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1 MODBUS TOOLS 

Modbus Tools is a powerful multi-purpose Windows-based software package for use off-line. 

It uses and outputs fully MS DOS-compatible files that can be saved locally to hard or floppy disk, or 

transferred to and from target instruments at high speed over the following communications medium. 

LIN via PCLIN or PC cards 

ELIN via an Ethernet port 

ALIN via a PCALIN or Arcnet card 

via a serial port (SLIN) 

It is used to define the communication method between LIN and Modbus instruments, for example, 

Programmable Logic Computers (PLC’s), and third-party supervisors. 

1.1 OVERVIEW OF MODBUS TOOLS 

Modbus Tools is used to define the communication between LIN and Modbus instruments, for example, 

Programmable Logic Controllers (PLC’s), and third-party supervisors. 

The Modbus configuration runs alongside a regular LIN Database, in a Project instrument environment 

provided with a Modbus interface, referred to as a Gateway. The Modbus configuration defines the 

communication between the LIN Database and the Modbus device. This enables the integration of devices 

external to the LIN, for example PLC’s, and permits communication with third-party supervisors. 

Note 

Modbus Tools is part of a Project based suite of tools and can also be used to configure instruments operating 

within a single instrument environment. 

 

Modbus Tools offers: 

A common toolset for Modbus supported products. 

Automatic documentation. 

The LIN instrument may be configured either as a Master, communicating with one or more Modbus 

instruments, or as a slave. 

The Modbus configuration data is defined in a source file (.ujg). 

A Modbus GateWay file (.gwf) is generated and this is downloaded along with the LIN Database (.dbf) file into 

a LIN instrument. Some instruments support more than one Modbus Gateway facility, each can specify a 

unique Gateway file via a GW_CON block. Each GW_CON block specifies a Gateway file defining the 

communication parameters required to transfer data between the LIN Database and Modbus registers in 

instruments in this individual Gateway facility. 

Note 

An appropriate number of GW_TBL blocks can be added to a LIN Database if the features it contains are 

required to access the Modbus diagnostic data. The GW_TBL block is a more efficient way of accessing Modbus 

diagnostic data than via a table, and also has the advantage of releasing one table for the configuration. 

Configuring the GW_TBL block disables the corresponding diagnostic tables, thereby avoiding bit-value conflicts. 

Refer to the LIN Blocks Reference Manual (Part no. HA082375U003), in Online Books, for full details. 
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1.1  OVERVIEW OF MODBUS TOOLS (Cont.) 

This Modbus GateWay file data defines: 

The operating mode (Modbus master or slave). 

The communications link set-up (Serial or TCP). 

The mapping between fields in LIN function blocks and the registers of a Modbus instrument. 

How field values are transferred between instruments. For example which Modbus function codes to use, the 

addresses of Modbus registers and the format in which data is to be transferred. 

1.2 LIN INSTRUMENT MODBUS CAPABILITIES 

When a Modbus configuration is associated with a LIN Database, the instrument target library version is read 

from the database file to determine the LIN Instrument Modbus capabilities. 

Note 

Instruments that do not support instrument and communication parameter configuration by means of either 

on-screen menus or the Instrument Options tab on the Instrument Properties dialog can use an appropriate text 

editor, i.e. ‘notepad.exe’, to edit it. 

The following is a summary of the capabilities that can be defined for each instrument type: 

1.2.1 Memory Size 

This is the memory available in the instrument for Modbus data to be downloaded to. This value is shown in 

the GWF Size - Max Size on the Port Properties tab. 

Max Tables 

This is the maximum number of tables supported by the instrument. This value is indicated by the GWF Tables 

- Max on the Port Properties tab. 

1.2.2 Operating Mode 

The Operating Mode can be changed, if the instrument type supports the selected, Master or Slave, operating 

mode on the Port Properties tab. 

1.2.3 32-bit 

The instrument type may support mapping of pairs of analogue registers to 32-bit IEEE format. If supported 

the 32-bit option is included in the Format selection on the Register tab. 

1.2.4 2-bit Swapped 

The instrument type may support mapping of pairs of analogue registers to 32-bit IEEE format Word Swapped 

with low word first. If supported the 32-bit - Swapped option is included in the Format selection on the 

Register tab. 

1.2.5 Tick Rate 

If supported then the Tick Rate options are enabled (in Master mode only). Values for Slow, Medium and Fast 

tick-rates are edited in the Port Properties tab Tick Rate. Slow, medium or fast Tick Rate can be selected in the 

Tables tab. In Slave mode the Tick Rate value remains read-only ‘Default’. 

In auto-create table mode, the tick-rate value for individual registers can be modified, but this affects the 

allocation of registers to tables. 
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1.2  LIN INSTRUMENT MODBUS CAPABILITIES (Cont.) 

1.2.6 Instrument Options 

For most instrument types, all instrument options are defined within the Modbus Tools and saved in the 

Modbus Gateway file, .gwf. For certain instrument types, the options are specified using the Instrument 

Options editor. These options include Slave Addr. (in Slave mode), Baud Rate, Parity, Stop Bits (in Serial mode) 

and Timeout. 

1.2.7 Interface Type 

The instrument type may support Serial (EIA232) and TCP interface types. The Instrument may support one or 

more port connections for the selected Interface Type. 

1.2.8 Number of Interfaces of each Type 

The instrument type may support one or more port connections for the selected Interface Type. If Serial is 

selected, the Serial Port setting (Serial Port: COMn) in the Operating Mode section shows the port used for 

Modbus Serial communications. If TCP is selected, the Serial Port setting changes to TCP port (TCP port: n) 

and shows the port used for TCP/IP communications. 

1.2.9 CNOMO Registers 

The instrument type may support Comité de Normalisation des Moyens de production (CNOMO) registers. 

The CNOMO registers return manufacturer and product detail values when the instrument is configured to 

operate in Modbus Slave mode only. It displays the Manufacturer’s ID, Device type i.e. LIN identifier value, and 

Device version at pre-defined Offset values 121, 122, and 123 respectively in the Register tab. 

Note 

Offset value 124, will display the instrument status, Device heartbeat. 

1.3 CONVENTIONS 

Where specific computer keys have to be operated, this is signified as in the following example: 

<Ctrl> + <C> 

which means ‘Hold the control key down whilst operating the C key’. 

Some keyboards may have different key legends. <Delete> for example, may appear as <Del>. 

1.4 STARTUP 

Modbus Tools can be invoked by: 

Double-clicking on a .ujg file in the LINtools project workspace view, or 

Double-clicking on a .ujg file in a LIN instrument project folder. 

Note 

The Modbus Tools may also be started using Command Line Parameter statements. 
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2 VIEW 

As shown in the figure below, Modbus Tools is presented as a single tabbed view with an error report window. 

 

The tabs are named: 

Port Properties  

Register  

Digital  

Diagnostic  

Tables  

And are all described in separate topics. 
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2.1 TOOL BAR 

 

Note: 

The Toolbar can be displayed or hidden using the View menu ‘Toolbar’ item. 

New. This command is used to create a new Modbus configuration. The user is prompted to select a LIN 

database file to be referenced for LIN block field tag browsing. 

The file menu command ‘New’ and the shortcut <Ctrl> + <N> can be used as alternatives. 

Open. This tool is used to open an existing Modbus configuration. If a LIN database file has not already 

been specified, the user is prompted to select a LIN database file to be referenced for LIN block field tag 

browsing. 

The file menu command ‘Open’ and the shortcut <Ctrl> + <O> can be used as alternatives. 

Save. This command is used to save the active Modbus configuration to its current name and directory 

(folder). The first time a configuration is saved, the ‘Save As‘ dialogue box appears to allow the configuration 

path name to be defined. The file menu command ‘Save’ and the shortcut <Ctrl> + <S> can be used as 

alternatives. 

To save an already-saved configuration to a different path name, use the File menu ‘Save As…’ command. 

Cut. This deletes the highlighted registers from the configuration and places them on the clipboard for 

pasting elsewhere. The Edit (or right-click) menu command ‘Cut’ and the shortcut <Ctrl> + <X> can be used 

as alternatives. 

Copy. This copies the highlighted registers from the configuration and places them on the clipboard for 

pasting elsewhere. The original items remain in place. The Edit (or right-click) menu command ‘Copy’ and the 

shortcut <Ctrl> + <X> can be used as alternatives. 

Paste. Imports register data from the clipboard into the configuration. The Edit (or right-click) menu 

command ‘Paste’ and the shortcut <Ctrl> + <V> can be used as alternatives. 

Paste special. Imports register data from the clipboard into a new destination within the configuration. The 

Edit (or right-click) menu command ‘Paste Special…’ and the shortcut <Ctrl> + <Q> can be used as 

alternatives.  

Undo. This reverses up to the last six editing actions, if possible. The Edit (or right-click) menu command 

‘Undo’ and the shortcut <Ctrl> + <Z> can be used as alternatives. 

Redo. This reverses the last ‘Undo’ action, if possible. The Edit (or right-click) menu command ‘Redo’ and 

the shortcut <Ctrl> + <Y> can be used as alternatives. 

Print. Initiates printing of the configuration, via the standard Printer Dialogue box, which allows the user to 

select the required printer, paper source, single/double sided etc. 

Add registers. Allows the user to add one or more registers to the table as described in ‘Adding Registers’. 

TCP Properties. See the separate topic: TCP Properties. The View menu ‘TCP Properties’ item, or the 

shortcut <Ctrl> + <D> can be used as alternatives. 

Open database. Clicking on this toolbar icon opens the target database in LINtools. 

Back. This returns the user to the calling application. For example, if this instance of Modbus Tools has 

been launched from LINtools by double-clicking a Modbus file in the contents window, then clicking on this 

icon returns the focus to LINtools. 

About. Displays details about this version of Modbus tools. Also available from the Help menu ‘About Mdb 

Tools…‘ item. 
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2.2 REPORT WINDOW 

 

Located in the lower part of the display area, this window displays validation errors. 

Registers or table data which fail the validation checks are displayed in Red. 

Validation is carried out 

When a .upg file is loaded 

When a .upg file is saved 

Whenever data is modified 

Validation involves checking that the data is complete and that it is consistent with the LIN Database (.dbf) file 

- i.e. the referenced LIN fields exist in the .dbf file and are of the correct type. 

Double clicking on an error causes the tabbed window to jump to the erroneous data. 

The Report Window can be toggled on and off from the View menu, or by typing <Alt> and <V> 

simultaneously, then <R>. 

2.3 STATUS BAR 

The Status bar is to be found at the bottom of the display area. The status bar can be toggled on and off, 

using the View menu ‘Status Bar’ item, or by typing <Alt> and <V> simultaneously, then <S>. 

 

The left hand area of the status bar contains tool tips information, giving a brief description of tool bar or 

menu commands whilst the cursor is hovering over them. 

The right hand area contains details of the port properties mode (Mode: MASTER or Mode: SLAVE), Auto-

create tables mode (AUTO create tables or MANUAL create tables) and the percentage of GWF memory that 

has been used so far. 

The status of the computer keyboard lock keys (CAP, NUM and SCRL) is also displayed. 
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2.4 EDITING TECHNIQUES 

2.4.1 Drop down menus 

(Also known as ‘Combo’ menus.) 

Drop down menus present the user with a number of fixed-value items to choose from. The required value is 

clicked on to select it, and the menu then closes. 

Drop down menu items are displayed when the associated down-arrowhead button  is clicked-on. In some 

cases, these arrow heads are permanently visible (example 1), in other cases the list appears only when the 

relevant column is clicked-on (example 2). 

 

Example 1 Example 2  

2.4.2 Text/Numeric Entry 

(Also known as ‘String entry’.) 

Text entry and numeric entry techniques are identical except that for number only fields (e.g. tick rate entry) 

there is checking for valid numeric data. 

On the Port Properties tab, non-numeric characters are disabled. 

On the Register tab and Tables tab, numeric data is checked after an edit (i.e. when ENTER is pressed or when 

another cell is selected). If the data is invalid or out of range an error message appears and the data is 

restored to the original value. 

Click somewhere within the text or numeric field. The cursor appears either at the right hand end of the 

existing entry, or within the existing entry, depending on the ‘click’ position. 

The existing text can then be edited, deleted, overwritten, replaced etc. using normal keyboard entries. 

 

Typical numeric entry field Typical text entry field 

2.4.3 Multiple editing 

This allows the user to select a number of registers and to edit them all in a single action: 

Select the required registers (1 to 6 in the example below, though they need not be contiguous), 

with the control (<Ctrl>) key held down, make the required edit to one of the selected items (Register 2 in 

the example). 

All the selected items have the edit applied to them. 

 

2.4.4 Multiple Item selection 

Use <Shift> and the left mouse button to select a continuous range of registers. 

Use <Ctrl> and the left mouse button to select multiple non-contiguous registers. 
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3 PORT PROPERTIES TAB 

 

For some instrument versions, the Link settings area appears as shown below, where the serial 

communications parameters can be edited directly to match those of the rest of the system. 

 

For further details, see: 

Files  

Operating Mode  

TCP Properties  

Link Settings  

Instrument Options  

Tick Rates  

GWF Tables  

GWF Size  

Auto-Create tables  

CNOMO Registers  

Note 

If the instrument Options configuration is defined in hidden library files, some fields can only be configured via 

the Instrument Properties dialog. 
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3.1 FILES 

3.1.1 File Name 

This gives the path name for the currently loaded .ujg file. 

3.1.2 Database 

This displays the database file currently being used. This may be changed by clicking on the button to the 

right of the field, and browsing for the required database. 

 

3.2 OPERATING MODE 

Operating mode selection is to be found in the Port Properties tab display, and allows the user to select 

Master or Slave and Serial or TCP modes of operation. Selections are greyed out or omitted for instruments 

which do not support the relevant mode. 

Note 

If the instrument type handles properties via the Instrument Options Editor, this section does not include the 

Slave Address property. 

3.2.1 Mode 

Allows the user to select ‘Master’ or ‘Slave’ for the instrument. For instruments which do not support master 

mode, the mode is automatically set to ‘Slave’ and is non-editable. 

When master mode is selected, the ‘Slave Addr.’ Field (if present) is greyed-out (i.e. it is non-editable). 

     

 

3.2.2 Slave Addr: 

For older instruments (which do not support the system.opt file), this allows the user to select a Modbus Slave 

address (0 to 255) for the instrument. This address must be unique to the link.  The field does not appear for 

instruments which do support the system.opt file - for such instruments the set up is carried out using the 

Instrument Option Editor accessed by clicking on the 'Instrument Options...' key. 
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3.2.3 Serial/TCP 

These radio buttons allow Serial or TCP to be selected as the communications interface type. For instruments 

which do not support both, the relevant button is disabled (greyed out). 

For instruments whose communications properties are configured via the Instrument Option Editor, the Link 

Settings panel presents a button to open the editor to allow communications parameters to be edited. For 

instruments that do not use the Instrument Options Editor, the communications parameters are set in the Link 

Settings panel. 

SERIAL MODE 

When Serial is selected the Baud Rate, Parity, Stop bits and Timeout need to be configured. 

The Serial Port name is shown. If multiple Serial Ports are supported then the required Serial Port can be 

selected. 

 

TCP MODE 

If TCP is selected, then the TCP Port setting can be edited. The TCP Port number can be edited to any value 

between 0 and 65535 inclusive. The default Port number is 502. 

 

When configuring a LIN instrument as a TCP master, the TCP port characteristics are set up in the TCP 

Properties dialog. The TCP Properties dialog can be accessed from the button to the right of the TCP radio 

button, the View menu, by using the short cut <Ctrl> + <D> or the TCP Properties tool. 
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3.2.4 TCP Properties (Devices tab) 

Note 

If a TCP (.uxm) file is read only, then so are the TCP properties which appear in this display. 

 

Clicking on this tool opens the TCP properties display, a typical example of which is shown below. TCP 

properties are defined in a file called "<dbName>.uxm" in the instrument folder. The TCP Properties page can 

also be invoked from the TCP button on the Port Properties tab to the right of the TCP radio button, the View 

Menu ‘TCP Properties’ item, or by using the shortcut <Ctrl> + <D>. 

There are two Tabs: ‘Devices’ and ‘Properties’. The Devices tab is described within this topic; the ‘Properties’ 

tab in a separate topic. 

 

The ‘Devices’ tab allows devices to be added and/or removed from the configuration. 

The list of device properties will be displayed in a grid. Device properties include Name, Instrument number, 

Slave address, IP Address & Port. 

NAME  

ModbusTCP instrument device name can be any combination of alpha and numeric characters. See ‘Editing 

Techniques’ for text editing details. 

INSTR. NO. 

This number (between 1 and 255) is mandatory for GW-modbus and is the decimal Modbus address as 

defined in the GW tables "Instr No". See ‘Editing Techniques’ for numeric editing details. 

SLAVE ADDR. 

This number (between 1 and 255) is mandatory and is the decimal Modbus address of the ModbusTCP 

instrument device. See ‘Editing Techniques’ for numeric editing details. 
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3.2.4  TCP PROPERTIES (DEVICES TAB) (Cont.) 

IP ADDRESS 

This is mandatory and is the TCP/IP IP Address of the ModbusTCP instrument device or its TCP/IP address in 

standard ‘decimal’ notation*. If an IP Address is used, the Modbus comms needs to resolve it. See ‘Editing 

Techniques’ for text/numeric editing details. 

*a.b.c.d, where a, b, c and d can have any value between 0 and 255 

If an invalid address is entered, a warning message appears. 

PORT 

This is the decimal TCP/IP port number (0 to 65535) for the Modbus comms in the ModbusTCP instrument 

device. If this parameter is missing 502 is used by default. See ‘Editing Techniques’ for numeric editing details. 

Buttons are provided to Add a new device and to Remove a selected device. 

 

3.2.5 TCP Properties (Properties Tab) 

This TCP Properties tab is depicted below. 

 

This display page allows the editing of the main TCP properties as defined in the .uxm file. 

The "Defaults" button enables all properties to be reset to default values. 

HOST RESOLUTION RETRY DELAY 

The address of a Modbus TCP device can be specified by name or IP address.  

If an IP address is used, no resolution effort is required, so the value for the host resolution retry delay is not 

relevant. 

If a name is used, the system must ‘resolve’ the name to an IP address. Once the resolution process is 

successful, the resulting IP address is used for communications.  

The Host resolution retry delay (default = 300000 msec (5 mins)) defines the frequency at which the system 

attempts to resolve the IP Address. Usually, the name is resolved immediately, but the process may fail and, in 

such a case, setting the delay to too low a value can reduce performance because of the processing effort 

involved.  
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3.2.5  TCP PROPERTIES (PROPERTIES TAB) (Cont.) 

CONNECT INITIAL DELAY 

The initial delay (default 100msec). incurred before attempting to connect to a Modbus TCP instrument 

device immediately its IP Address has been resolved. It is not recommended that this value is changed from 

the default. 

Note that all connection requests are executed asynchronously to avoid blocking the Modbus 

communications in the ‘connect()’ call. 

CONNECT RETRY 1 DELAY 

The delay (default = 1000msec.) incurred before the first retry to connect to a Modbus TCP instrument 

device. 

CONNECT RETRY 2 DELAY 

The delay (default = 2000 msec.) incurred before the second retry to connect to a Modbus TCP instrument 

device. 

CONNECT RETRY 3 DELAY 

The delay (default = 5000 msec.) incurred before the third retry to connect to a Modbus TCP instrument 

device.  

RECONNECT RETRY DELAY 

The delay (default = 0 msec.) incurred between subsequent retries (after the third) to connect to a Modbus 

TCP instrument device. 

RECONNECT NUM RETRIES 

The number of retries (default = 5) to connect to a Modbus TCP instrument device at intervals of the 

Reconnect retry delay. Once all retries have been exhausted the algorithm reverts to Connect retry 1 delay 

and repeats. 

ASYNC CONNECT POLL TIMEOUT 

The period of time (default = 10 msec.) that the Modbus comms will wait for a connection to succeed or fail 

whilst polling for the completion of a connection request. This defines the amount of time the Modbus 

comms will hang in the ‘select()’ call. 

ASYNC CONNECT TIMEOUT 

The period of time (default = 0 msec.) that the Modbus comms will tolerate before cancelling a connection 

request that has yet to complete. 

If this tuning parameter is missing a default value of 0 is applied. A value of 0 relies on the Windows 

implementation of the ‘connect()’ call to fail a connection request, any other value can be used to circumvent 

the time imposed by Windows. 
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3.3 LINK SETTINGS 

‘Link settings’ is to be found on the Port Properties tab and appears as one of the figures below, depending on 

instrument variant. 

   

3.3.1 Serial Settings 

When Serial is selected as the Operating Mode, Baud Rate, Parity and Stop bits configuration fields are 

enabled, otherwise, they are greyed out. 

3.3.2 Time out 

The communications time out (0 to 65535 ms) can be entered here. Default is 500 ms. 

3.3.3 Instrument Options… 

In certain LIN instruments, some aspects, e.g. HMI, ports, etc. are handled using the Instrument Options Editor 

(LIN Modbus Capabilities Instrument Options) invoked by clicking on the ‘Instrument Options…’ button in the 

Link Settings area of the Port Properties tab. The instruments Editor has its own individual Help system which 

opens when the ‘Help’ button at the bottom of the Editor Window is operated. 

The Instrument Options Editor can, 

1. read/write changes into an instrument file 

2. organise and present possible configuration options to the user 

3. communicate with online instruments in order to both read their current options settings and 

download modified options files 

4. instruct an instrument (via LIN messages) to reload any Instrument Option settings that do not 

require the power to first be isolated then re-applied 

5. present the user with only the configuration options applicable to the target instrument 

Note 

The Instrument Options Editor can also be launched from both LINtools and Windows Explorer. 

 

For successful communications, the Master/Slave etc. settings in the Operating Mode area must match the 

settings made in the Instrument Options Editor. See ‘Port selection ’ for details of which port(s) should be 

configured for various instrument types. 
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3.3.3  INSTRUMENT OPTIONS (Cont.) 

SERIAL MODE 

When Serial mode is selected in the Modbus Tools, the ‘Instrument Options …’ button opens the Instrument 

Options Editor with the ‘Serial’ properties selected. 

 

 

Port Select the required port. The settings for each port are specified in a column headed by the 

name of the port, e.g. ‘COM1’, ‘COM2’, etc. The selected port indicates the port used for 

Modbus Serial communications. 

Protocol The protocol for the given port needs to correspond to the operating mode specified in the 

Modbus Tools. For Master mode, select protocol Modbus-M. For Slave mode, select protocol 

Modbus-S. 

Address The LIN Slave Address. 

Baud, Parity and Stop bits 

Allows these serial properties to be specified. 

Timeout Allows the comms timeout to be specified. 

3or 5 wire For use on targets where the Serial interface can be configured for 3-wire or 5-wire operation 

under program control. 
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3.3.3  instrument options (Cont.) 

TCP MODE 

When TCP mode is selected in the Modbus Tools, the ‘Instrument Options …’ button opens the Instrument 

Options Editor with the ENET’ (Ethernet) properties selected. ‘Port Selection ’ gives details of which port is 

suitable for which protocol for a number of instruments. 

 

 

 

Timeout Allows the comms timeout to be specified. 

 

Note 

The Instrument Options Editor uses the instrument type specified in the instrument folder in order to apply 

rules about which options are supported. These capabilities are based on the LIN Database (.dbf) file that is 

specified as part of the Modbus Configuration. If there is a conflict between these instrument types, i.e. if the 

Modbus Tools has selected a LIN Database (.dbf) file for a different instrument type to that specified in the 

instrument folder then a conflict may arise in getting the Instrument Options settings to correspond to those in 

the Modbus Tools. If this occurs, then either change the instrument type in the instrument folder or move the 

Modbus configuration (.ujg) and corresponding LIN database file (.dbf) to a different folder. 
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3.3.3  INSTRUMENT OPTIONS (Cont.) 

PORT SELECTION 

This topic describes how to determine the relevant port for configuration. 

When TCP and Master are selected in the Operating mode area of the Port properties tab, then ENET 4 should 

be used. Use ENET3 for TCP slaves. 

If Serial Master or Slave is selected, then click on the ‘Instrument Options’ button in the Link Settings area of 

the Port properties page. In the resulting display, use the pull down menus to display and select a suitable 

Master/Slave option for each port. 

 

Note:  

As shown above, the pull down menu appears when the relevant area is clicked on. 

3.4 TICK RATES 

 

If the LIN instrument does not support tick rates, and/or if the instrument is set up as a Modbus slave, the 

Tick Rate edit fields are disabled. 

If the LIN instrument supports Tick Rates, and it is configured as a Modbus Master, then this area of the Port 

Properties tab tab allows values (between 0 and 65535 ms) to be entered for the Slow, Medium and Fast tick 

rates. 

Each table of registers is assigned one of these tick rates to define the frequency at which it is scanned. The 

tick rate associated with each table can be modified in the Tables tab. 

The tick rate associated with an individual register can be selected (slow, medium or fast) in the relevant 

Register tab or Digital tab. In Auto Create tables mode, this affects the allocation of registers to tables. 
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3.5 GWF TABLES 

GWF Tables is to be found in the ‘Port Properties tab’. 

 

Number The number of tables currently in use. 

Max Displays the maximum number of gateway tables available for the current instrument (see LIN 

Instrument Modbus Capabilities). 

3.6 GWF SIZE 

GWF Size is to be found in the ‘Port Properties ’ tab. 

 

Max Size The memory space available within the LIN instrument, into which Modbus data (as defined in 

the GWF file) can be downloaded. 

Size The amount of memory being used by the current Modbus configuration. 

Free The remaining amount of memory, available for use. 

3.7 AUTO CREATE TABLES 

‘Auto-create Tables’ is to be found in the Port Properties tab. 

 

With this option ticked (default), the allocation of registers to tables is automatic. User editing of the tables is 

restricted if ‘Auto-Create’ is selected. 

Contiguous blocks of registers associated with a given Modbus slave are assigned to a single table (if possible). 

All registers contained in one table are scanned in a single Modbus transaction. 

If a contiguous block of registers exceeds the maximum number for a single transaction (2000 digitals, 125 

registers) then the excess registers are assigned to a new table. 

If, in an otherwise contiguous block of registers, there is a gap that does not exceed the maximum allowable 

gap (320 digitals, 20 registers), then the registers will still be assigned to a single table. 

If the tick rate of an individual register is modified, then that register will be assigned to a new table. 

If Auto create tables is not ticked, the user must specify type, slave address/instrument number, offset and 

count for each table, manually. Tables must be defined (in the Tables tab) for all registers to be scanned. 
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3.7.1 Diagnostic Table 

In auto-create tables mode, a further option ‘Diagnostic table’ is enabled for user selection. If selected, a 

diagnostic table will be created consisting of a special set of registers containing status and control bits to 

allow the LIN database to interact with the MODBUS drivers. The default diagnostic registers will be added 

into the Diagnostic tab register view. 

When not in auto-create tables, a single Diagnostic tab can be manually configured in the Tables tab. 

3.7.2 CNOMO Response 

Certain instrument types have the ability to respond to specific CNOMO registers (LIN Modbus Capabilities 

CNOMO Response). 

The CNOMO registers apply to specific data that can be read at pre-defined offsets namely Manufacturer’s 

identity (121), Device type (122), Device Version (123) and a further register Device Heartbeat (124) reserved 

for future use. 

If an instrument is capable of a CNOMO response, then this can be enabled via the check-box on the Auto-

create panel of the Port Properties tab. 

If CNOMO response is enabled then the user will be prevented from using registers in the CNOMO range, 

121-124. If a user adds registers that span these locations then those registers will be reserved as read-only for 

CNOMO use and can not be re-assigned by the user. 

 

If an attempt is made to add 32-bit registers that overlap with the CNOMO offsets then 16-bit registers will be 

inserted alongside the CCNOMO registers to maintain even boundary alignment of 32-bit registers. 

WHAT IS A CNOMO REGISTER? 

The Comité de NOrmalisation des MOyens de production (CNOMO) registers are set of pre-defined offset 

values that return manufacturer and product details value. These Offset values can only be used when the 

instrument is configured to operate in Modbus Slave mode. 

It return manufacturer’s identity, Device type i.e. LIN ident value, and Device version values on the Register 

tab at pre-defined Offset values 121, 122, and 123 respectively. 

Note 

The Offset value 124, displays the instrument status, Device heartbeat. 
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4 REGISTER TAB 

 

This page shows the analogue registers configured for the various Modbus instruments. 

To select a register for edit, click anywhere within the relevant row. 

Use <Shift> and the left mouse button to select a continuous range of registers. 

Use <Ctrl> and the left mouse button to select multiple non-contiguous registers. 

See also: 

Adding Registers  

Moving Register  

Cut, Copy and Paste  

Unmapped Registers  

Slave Addr  

Instrument No.  

Offset  

Field  

Format  

Decimal places  

32-Bit Date and Time  

Read-Write  

Table  

Tick Rate  

Description  
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4.1 ADDING REGISTERS 

To add further registers: 

Click on the ‘Add Registers’ Tool , 

Use the edit menu‘Add Registers’ entry, 

Use the right click ‘Add Registers’ entry, 

Use the shortcut <Ctrl> + <R>. 

Double-click on a blank row in the Register grid. 

Double-click on the Slave Addr./Instr. No. or Offset field of an existing register to invoke the Add Registers 

dialogue, with initial values based on the selected register.  

Note 

The Add Registers dialog enables the user to add new registers. It cannot be used to modify fields of an existing 

register. 

Any of the above calls the ‘Add Registers’ dialogue box, allowing the user to define further registers. The 

default characteristics are the same as those of the highlighted register, except that the Offset value is set to 

the next available offset. Typical displays for analogue and digital registers are shown below. 

  

In Auto-create tables mode, all new registers are assigned to a table. When not in ‘Auto-create tables’ mode, 

new registers are ‘unassigned’. 

Note: 
Data in Modbus Tables will become corrupt if registers containing 32-bit or 32-bit Swapped data type runs contiguously between different 

Tables. 

4.1.1 Slave Addr. 

Shows the slave address of the highlighted register. This may be edited to any existing or new slave address 

within the range 0 to 255 inclusive. In slave mode the value is automatically set to the LIN instrument slave 

number defined in the Operating Mode area of the Port Properties tab. 

Replaced by ‘Inst. No.’ (below) for Operating mode = TCP Master. 

4.1.2 Inst. No. 

For Master TCP mode only, this is the decimal Logical LIN instrument number (1 to 255) which corresponds 

with the defined physical TCP address of a Modbus slave instrument. 

For other modes, Inst. No. is replaced by ‘Slave Addr.’, above. 

See also TCP Properties  
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4.1.3 Offset 

Shows the first available offset, in the table associated with the highlighted register. The offset value may be 

between 0 and 65535 inclusive. 

If an attempt is made to add a range of registers that conflicts with one or more existing registers, then only 

intervening registers are added. Pre-existing registers are NOT overwritten (i.e. any existing mappings or 

register field edits are retained). 

4.1.4 Count 

The number (0 to 65535) of new registers to be added, starting at the Offset address. 

4.1.5 Format 

Allows a number format to be selected for the field. 

 

4.1.6 DP 

Allows the user to select the number of decimal places to be applied, between none and four. 

4.1.7 Read-Write 

 

This picklist defines the direction in which the data will pass between the Master and the Slave. 

  

No data is passed between the Master and the Slave. 

 

  

Master: This register is periodically updated with data requested by the master from the Slave. 

Slave: The content of this register can be read by the Master. 

 

 

Master: When the content of this register changes, it is written by the Master to the Slave. 

Slave: The content of this register is intermittently updated by the Master. 

 

  

Master: When the content of this register is changed by the Master, it is written to the Slave. 

Slave: When the content of this register is changed by the Slave, it is written to the Master. 

 

The LIN instrument Operating Mode selection is made in the Port Properties tab. 
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4.2 MOVING REGISTERS 

Once a register hs been added into the Register grid, the properties of the register may be edited. However, 

the Slave Addr./Instr. No. and Offset fields that uniquely identify the register may not be edited. 

If it is required to move or copy existing registers to a different Slave Addr./Instr. No. and Offset, this can be 

achieved using the Cut/Copy and Paste/Paste Special operations in the Edit menu. 

To move selected registers, use the Cut (Ctrl-X) in the Edit menu. The registers will be removed from the grid. 

To relocate the registers, use the Paste Special (Ctrl-Q) operation in the Edit menu. This will present a dialog 

allowing the specification of a user-defined location. The removed registers will then be re-inserted into the 

grid at the new Slave Addr./Instr. No. and Offset locations. 

4.2.1 Cut, Copy and Paste 

Analogue and digital registers can be deleted, copied or moved using the Delete, Cut, Copy, Paste and Paste 

Special operations, accessed via the Edit menu, the context (right-click) menu or the tool bar tools (not 

delete). 

If any attempt is made to paste overlapping registers, a warning message appears, giving the user the 

opportunity to overwrite those registers which are overlapped, to paste to a different location or to cancel the 

paste operation. 

 

 

Clicking on Paste To… calls the following display, allowing the user to edit the paste destination. 
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4.3 UNMAPPED REGISTERS 

When not in Auto-create mode, tables can be configured manually. 

Corresponding unmapped (virtual) registers will be automatically added into the appropriate registers view. 

This saves the user the extra effort of creating registers that have already been defined within the range of an 

existing table. 

Unmapped registers are displayed in italics. 

Groups of unmapped registers may be displayed in a compressed format (single row) 

 

or expanded using the +/- button to show the individual registers.  

 

In order to configure an unmapped register, click on a grid cell to edit the data in the normal way. When data 

is applied to an unmapped register, it is no longer a virtual register and is no longer displayed in italics. 

4.4 COLUMN HEADINGS 

4.4.1 Slave Addr 

The address (in the range 0 to 255) of the slave instrument. (See ‘Editing techniques’ for text/numeric editing 

details)  

In Auto-Create mode the Slave Addr. is not editable. 

In Slave mode, the Slave Addr. of the LIN instrument being configured is used. 

In TCP Master mode, ‘Slave Addr.’ is replaced by ‘Instrument No.’. 

See also TCP properties. 

4.4.2 Instr No. 

For Master TCP mode only, this is the decimal Logical LIN instrument number (0 to 255) which corresponds 

with the defined physical TCP address of a Modbus slave instrument. 

For other modes, Instrument No is replaced by Slave Addr.. 

See also TCP Properties  

4.4.3 Offset 

This defines the offset for each register in the range 0 to 65535 inclusive. 

If the number format of a register is 32 bit, then the register occupies two adjacent offset addresses. 

Digitals defined as having width = n, occupy n adjacent offset addresses. For n > 1, the register may be 

displayed in a compressed format (single row) or expanded using the +/- button to show the individual bit 

mappings. See ‘Digital Tab’ for examples. 

Multiple bit digitals must start at an 8 bit boundary relative to the start of the table or an error will be 

reported. 
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4.4.4 Field 

 

The LIN Field value may be edited directly, by typing-in the relevant block and field name.  

Alternatively, the LIN database browser can be opened (by clicking on the browse button to the right of the 

field value, (see above)) to provide the user with a quick and easy method of assigning LIN blocks to registers. 

The browser can be ‘pinned ’ by clicking on the ‘pin’ icon.  

 

Only LIN references which have data types valid for the type of register being mapped are offered for 

selection, as listed below. 

Field names can be set to ‘empty’ (i.e. unmapped) by clicking on the Clear button. Unmapped registers do not 

result in errors. 

ANALOGUE REGISTER DATA TYPES 

Analogue registers can be mapped to LIN fields of the following types: 

Single 

Long 

UnsignedLong 

String 

Date 

Time 
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4.4.4  FIELD (Cont.) 

DIGITAL REGISTER DATA TYPES 

Digital registers can be mapped to LIN fields of the following types: 

Boolean 

Alarm Bitfield 

Subfield 8 or subfield8.bitfield 

Subfield 16 or subfield16.bitfield 

4.4.5 Format 

Allows the number format to be selected from a list. 

Only those formats supported by the LIN instrument being configured are included in the list. See also LIN 

Instrument Modbus Capabilities. 

 

16-bit The normal register format 

32-bit IEEE format (if supported) 

32-bit swapped IEEE format but with low order word first (if supported) 

BCD 16-bit binary coded decimal. 

Note 

If either of the 32-bit formats is selected, the offset value changes to include two adjacent registers, and the 

decimal places selection is disabled. 32-bit formats must not run contiguously between different Tables. 

 

 

TIME AND DATE 32-BIT FORMAT 

If either 32-bit or 32-bit Swapped format is selected, an analog register can be mapped to a Time or Date 

function block field. In this case, the 32-bit Time or Date format is supported in the adjacent column (Decimal 

Places). 

 

A 32-bit Date field is read only format, ISO8601. 

A 32-bit Time field may be selected between ISO8601 and POSIX. 

For further details see 32-bit Date and Time. 
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4.4.6 Decimal Places 

Allows the selection of the number of decimal places between none (e.g. 1234.) and four (.1234). 

 

This field is enabled only when registers having 16 bit or BCD format are being edited. 

Note that in the case of a 32-bit format register that is mapped to a Time or Date function block field, the 

Time or Date format is supported in the decimal places column. 

 

 

4.4.7 Read-Write 

 

This picklist defines the direction in which the data will pass between the Master and the Slave. 

  

No data is passed between the Master and the Slave. 

 

  

Master: This register is periodically updated with data requested by the master from the Slave. 

Slave: The content of this register can be read by the Master. 

 

 

Master: When the content of this register changes, it is written by the Master to the Slave. 

Slave: The content of this register is intermittently updated by the Master. 

 

  

Master: When the content of this register is changed by the Master, it is written to the Slave. 

Slave: When the content of this register is changed by the Slave, it is written to the Master. 

 

The LIN instrument Operating Mode selection is made in the Port Properties tab. 
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4.4.8 Table 

This read only value shows the table number to which Modbus registers have been assigned. Contiguous 

tables for a given slave are separated by a thick grey line. 

Each table can have only one tick rate associated with it. In auto-create tables mode, changing the tick rate of 

one or more registers in a table results in the creation of a new table just for those registers. 

Note 
Tick rate can be edited only when ‘Master’ is selected in ‘Operating Mode’ in the ‘Port Properties tab’. 

4.4.9 Tick Rate 

 

Applies only to instruments that support ‘Tick rates’. 

See also LIN Instrument Modbus Capabilities. 

In master mode, this allows slow, medium or fast to be selected for each register. (See ‘Editing techniques’ for 

drop-down menus description)  

Each table can have only one tick rate associated with it. In auto-create tables mode changing the tick rate of 

one or more registers in a table will result in the creation of a new table just for those registers. 

Actual values for the three tick rates are entered in the ‘Tick Rates’ area of the Port Properties tab. 

4.4.10 Description 

This is a free-format text entry description for the table, of up to 100 characters. 

See ‘Editing Techniques’ for text editing details. 

4.4.11 Pinned 

When pinned the browser window remains open, allowing the user continuously to assign registers to fields 

without having to close and re-open the window each time.  

 

Pin icon when window unpinned. 

 

Pin icon when window pinned. 
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5 DIGITAL TAB 

 

 

This page shows the digital registers configured for the various Modbus instruments. To select a register for 

edit, it can be clicked on anywhere in the relevant row. 

Use <Shift> and the left mouse button to select a continuous range of registers. 

Use <Ctrl> and the left mouse button to select multiple non-contiguous registers. 

See also: 

Adding Registers  

Cut, Copy, Paste  

Unmapped Registers  

Slave Addr.  

Instrument No.  

Offset  

Field  

Width  

Read-Write  

Table  

Tick Rate  

Description  
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5.1 COLUMN HEADINGS 

5.1.1 Width 

 

Digital registers have a width property. This defines the number of bits that are mapped to a specified LIN 

field. 

If a digital register is mapped to multiple bits then the register may be displayed in a compressed format 

(single row) (208-215 above) or expanded using the +/- button to show the individual bit mappings (216-223 

above). 

Note 

Multiple bit registers must start at an 8 bit boundary, relative to the start of the table, or an error will be 

reported. 
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6 DIAGNOSTIC TAB 

 

 

The diagnostic table is a special set of registers containing status and control bits to allow the LIN database to 

interact with the MODBUS drivers. A diagnostic table allows MODBUS operation to be controlled, or 

diagnostic information to be presented to the LIN database. Only one diagnostic table need be configured per 

MODBUS configuration. 

In auto-create tables mode, a diagnostic table is created and the default diagnostic registers are added into 

the Diagnostic register view. 

When not in auto-create tables, a single Diagnostic table can be manually configured on the Tables tab. 

The diagnostic table is a special set of registers containing status and control bits to allow the LIN database to 

interact with the MODBUS tables. A diagnostic table allows MODBUS operation to be controlled, or diagnostic 

information to be presented to the LIN database. Only one diagnostic table need be configured per MODBUS 

configuration. 

See also: 

Offset  

Field  

Format  

Decimal Places  

Read-Write  

Table  

Tick Rate  

Description  

The registers of a diagnostic table are in two distinct sets --- the first sixteen at default addresses 0 - 15, and 

the following registers at addresses 16 onwards (one per table) up to the maximum number of tables 

supported. 
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6.1 REGISTERS 1 TO 16 

The first set of registers (with default addresses 0 to 15) are for internal diagnostic use, and are read-only to 

the user. They present general information on the operation of the MODBUS and their functions are 

independent of whether the instrument is operating as a master or a slave. The following lists these registers 

and their functions: 

0 (Unused) 

1 Flags 32-bit configuration errors (1 bit per table) 

2 Diagnostic register, bits currently allocated: Bit 5 --- Slave in listen-only mode 

3 Query data as transmitted by function code 8 sub code 0 

4 Input delimiter as transmitted by function code 8 sub code 3 

5 (Unused) 

6 (Unused) 

7 Count of error messages sent by slave 

8 (Unused) 

9 (Unused) 

10 (Unused) 

11 Master polling task: cycle period in 4 ms ticks 

12 Scanner task: time to check all tables in 4 ms ticks 

13 Scanner task: time used last time scheduled in 4 ms ticks 

14 Scanner task: time used for last delay in 4 ms ticks 

15 (Unused) 

6.2 REGISTERS 17 ONWARDS 

The second set of registers (with default addresses 16 onwards) allows individual tables in the configuration to 

be monitored and controlled. Each register in the diagnostic table is automatically allocated to an entire table 

in the configuration. Specifically, the diagnostic register at default address 16 is assigned to table 1, the 

register at address 17 is assigned to table 2, and so on up to the max number of tables. 

The function of this second set of registers depends on the systems current operating mode, Master Mode, or 

Slave Mode. 
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6.2.1 Master Mode 

 

WRITE ERROR CODE 

Normally zero. Otherwise it contains the error code associated with the last write to this table.  

READ ERROR CODE 

Normally zero. Otherwise it contains an error code associated with the reading of this table. 

DISABLE WRITE 

Setting this bit to 1 stops the master writing to the slave across the serial link.  

Note that when this bit is reset to 0, a write is forced to all the values in the table. 

SCAN COMPLETED 

This sets to 1 when the master has completed a scan of the slave. When operating in single scan mode, it 

indicates that the scan is finished and the data is available for use. It resets when the single scan bit is set, as 

described in the example below. 

SINGLE SCAN 

This is used in conjunction with the disable continuous scan bit. It allows a database sequence to initialise a 

single scan. 

DISABLE CONTINUOUS SCAN 

Setting this bit to 1 stops the master polling the slave across the serial link. 

ONLINE 

This sets to 1 when the slave is responding to the scanning routines. 

The single scan and scan completed bits are used together when a slave can be polled only under specific 

circumstances. A small sequence must be implemented to ensure that these bits are used correctly. The 

‘disable continuous scan’ bit must also be set. 

The suggested sequence for these operations is: 

Reset the single scan bit 

Wait till scan completed reset 

Set the single scan bit 

Wait till scan completed set 

The data is now valid 

Loop back to step 1 
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6.2.2 Slave mode 

In slave mode the diagnostic register includes bits that allow monitoring and control of the associated 

MODBUS table by the strategy running in the LIN database. 

 

The values in the register are used in the following way: 

DISABLE WRITE 

Setting this bit disables writes across the MODBUS serial link to the associated table. The slave will return 

error code 8 (see Table, Exception responses ). 

ONLINE 

This bit is set to 1 if the table has been written to or read from in the period defined in Time out. 

In master mode the diagnostic register includes bits which allow control by a database sequence of read/write 

operations when required by the application: 
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6.3 DIAGNOSTIC FUNCTION CODES 

Accessed by Modbus function code 8 

 

6.4 EXCEPTION RESPONSES 

The following error codes can be stored in bits 8 to B or C to F described in ‘Diagnostic Tab’ 

01 Illegal function The function is illegal or not supported 

02 Illegal data address The address does not exist within this slave 

03 Illegal data value The value in the data field is invalid 

04 Failure in associated device 

05 ACK (Acknowledge) 

06 Busy, rejected message 

07 NAK (Negative acknowledge) 

08 Write error. The data has been write protected via a bit in the appropriate diagnostic register. See 

‘Diagnostic Tab’ 

09 Zone overlap 

0A Header error 

0B Slave absent 

0C CRC error 

0D Write inhibited. The server has requested that a value be written to a slave, but none of the write codes is 

enabled for the table 

0E Incorrect length. The length of the response message does not match the expected length 

0F Slave Time out. No response was detected within the period defined in the Time-out parameter 
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7 TABLES TAB 

 

 

The Tables tab includes an entry for every configurable table for a given LIN target instrument. The maximum 

number of tables that can be configured for a given instrument is dependent on the LIN target library type. 

See also Lin Instrument Modbus capabilities. 

Table data that is incomplete or invalid is displayed in red and a corresponding message given in the report 

window. 

In Auto-Create mode, tables are automatically configured as registers are added. In this case Table Type, Slave, 

Offset and Count are read-only. 

When not in Auto-Create mode, tables can be configured manually. Corresponding virtual registers will be 

added as new tables are configured. See also Unmapped Registers. 

In Slave mode, the Scan Count, Function Codes and Tick-Rate are not shown. 

7.1.1 Editing cells on the tables grid 

Clicking on a cell activates an appropriate editor. For further details, see: 

Table Number  

Table Type  

Slave Addr. 

Instrument No. 

Offset  

Count  

Scan Count  

Function codes  

Tick rates  

Description  
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7.1.2 Table Number 

The tables tab contains a list of all available tables, whether used or not. The table number is not editable. 

7.1.3 Table Type 

Displays the type of registers associated with each table. (See ‘Editing techniques’ for drop-down menus 

description)  

In Auto-Create Mode the table type will be read-only. Otherwise, the table type may be selected as REGISTER, 

DIGITAL, DIAGNOSTIC or UNUSED. 

 

7.1.4 Function Codes 

The function codes that may be used to transfer registers assigned to this table. 

In Slave mode, the Function Codes are not shown. 

Clicking once within the cell, calls the Modbus Function Codes box as shown below. This allows the currently 

allocated codes to be enabled/disabled for the table. Function codes are automatically allocated according to 

register type. 

 

The possible function codes are as follows: 

Read digital output status 

Read digital input status 

Read analogue output registers 

Read analogue input registers 

Write single digital output 

Write single analogue output register 

Write multiple digital outputs 

Write multiple analogue output registers 
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8 MENU BAR 

 

The menu bar contains the following items, each of which is described in one or more separate topics: 

File menu 

Edit menu 

View menu 

Help menu 
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8.1 FILE MENU 

 

8.1.1 New 

This command is used to create a new Modbus configuration. The user is prompted to select a LIN Database 

file to be referenced for LIN block field tag browsing. 

Shortcuts: 

‘New’ tool , 

<Ctrl> + <N>. 

8.1.2 Open 

This tool is used to open an existing Modbus configuration. If another ‘instance’ of the selected file is already 

open, a message appears asking if a new instance of the file is to be opened or if the existing instance should 

be switched to. Where several instances are open, ‘Switch To…’ opens the first instance.  

If a LIN database is not specified, the user is prompted to select a LIN Database file to be referenced for LIN 

block field tag browsing. 

 

Shortcuts: 

‘Open’ tool , 

<Ctrl> + <O>. 

8.1.3 Save 

This command is used to save the active Modbus configuration to its current name and directory (folder). The 

first time a configuration is saved, the ‘Save As’ dialogue box appears to allow the configuration path name to 

be defined. 

Shortcuts: 

‘Save’ tool ,  

<Ctrl> + <S>. 
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8.1.4 Save As… 

The ‘Save As‘ dialogue box appears to allow the configuration to be saved to a new location. 

 

8.1.5 Save Special 

When clicked-on, this provides a single item menu selection ‘Text Listing’. If selected, Text Listing creates a 

‘simple text’ (.txt) file containing the Modbus configuration. 

8.1.6 Import CSV 

This command is used to load a CSV format Modbus configuration. When the required file has been selected 

from the file dialogue, the user is asked to define a delimiter from Comma, tab or space. 

Shortcut: <Ctrl> + <I>. 
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8.1.7 Export CSV 

This command saves the current configuration file in CSV format. When the required file name has been 

entered in the file dialogue, the user is asked to define a delimiter from Comma, tab or space. 

Shortcut <Ctrl> + <E>. 
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8.1.8 Page Setup 

 

This command allows the user to define the text entries in the title block that appears at the bottom of the 

page(s) when the configuration is printed. ‘Text 1’ to ‘Text 5’ in the figure above appear in the locations 

shown in the figure below. Date, page numbering, and the file and database names are non editable. 

 

BITMAP PATH AND FILENAME 

This allows the user to select a bitmap image (e.g. a logo) to appear below the Text 5 in the bottom left hand 

corner of the printed page(s). The path name can be typed in, or can be browsed for using the ‘Browse’ key. 

8.1.9 Print setup 

This command allows printer default settings to be entered for printed documents. 

8.1.10 Print Preview 

This command displays the active Modbus configuration as it would appear when printed. The Print preview 

toolbar allows the user to view one or two pages at a time, move forwards and backwards through the 

document, zoom into and out of pages, and to initiate the print. 
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8.1.11 Print 

This command calls the standard Printer Dialogue allowing the user to select a printer, paper source, single or 

double sided, number of copies etc. for the printed configuration. The default values can be set up in ‘Print 

setup’ described above. 

Shortcuts: 

Print tool ,  

<Ctrl> + <P>. 

 

Printed configurations consist of the following pages 

Port properties information, 

Table information 

Diagnostics information 

Modbus tables (one page for each configured table) 

8.1.12 Previous configurations 

This is a list of the last four Modbus configurations used. A configurations can be opened by clicking on the 

relevant file name. 

8.1.13 Exit 

This command quits the current Modbus Tools session. If there are unsaved changes, the user is asked if the 

changes are to be saved. 

 

Shortcuts: 

<Alt> + <F4>, 

Double click on the application control menu, then on ‘Close’. 
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8.2 EDIT MENU 

 

8.2.1 Undo (last action) 

Use this command to undo up to the last six editing actions (if possible). The item is ‘greyed out’ if there is no 

previous action to be ‘undone’. 

Shortcuts: 

‘Undo’ tool ,  

<Ctrl> + <Z>, 

Right click menu ‘Undo (last action)’ item. 

8.2.2 Redo (last action) 

Use this command to reverse the last undo action (if possible). The item is ‘greyed out’ if there is no previous 

undo action to be ‘redone’. 

Shortcuts: 

‘Redo’ tool , 

<Ctrl> + <Y>, 

Right-click menu ‘Redo (last action)’ item. 

8.2.3 Cut 

Deletes the current selected registers from the configuration and places them on the clipboard, ready for 

pasting elsewhere. The item is ‘greyed out’ if no registers are selected. 

Shortcuts: 

‘Cut’ tool ,  

<Ctrl> + <X>, 

Right-click menu ‘Cut’ item. 

8.2.4 Copy 

Copies the current selected registers to the clipboard, ready for pasting elsewhere. The original registers 

remain unchanged. The item is ‘greyed out’ if no registers are selected. 

Shortcuts: 

‘Copy’ tool , 

<Ctrl> + <C>, 

Right-click menu ‘Copy’ item. 
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8.2.5 Paste 

This inserts a copy of the clipboard register data into the document. The clipboard contents remain 

unchanged. The item is ‘greyed out’ if the clipboard is empty. 

Shortcuts: 

‘Paste’ tool ,  

<Ctrl> + <P>, 

Right click menu ‘Paste’ item. 

8.2.6 Paste Special… 

This inserts a copy of the clipboard register data into a new, user definable location. The clipboard contents 

remain unchanged. The item is ‘greyed out’ if the clipboard is empty or if multiple slaves are included in the 

clipboard content. 

Shortcuts: 

‘Paste To’ tool , 

<Ctrl> + <Q>, 

Right-click menu item ‘Paste Special…’ 

8.2.7 Delete 

This item deletes currently selected registers from the configuration. The item is ‘greyed out’ if no registers 

are selected. Unlike the ‘Cut’ command, deleted registers are not placed on the clipboard and cannot thus be 

‘pasted’. 

Shortcuts: 

<Delete> key, 

Right-click menu item ‘Delete’. 

8.2.8 Goto 

From the ‘Tables’ tab, this command moves the user to the Register or Digital tab which contains the 

highlighted table, and highlights the first register assigned to that table. 

From the Register tab or Digital tab, the command moves the user to the ‘Tables tab’ and selects the table 

that the selected register is assigned to. 

If multiple registers are selected, then the table associated with the first of the selected registers is moved to. 

If the register is not assigned to a table, no navigation takes place. 

The item is ‘greyed out’ if no registers are selected. 

Shortcuts: 

<Ctrl> + <G>, 

Right-click menu ‘Goto’ item. 

8.2.9 Add Registers 

This is used to add registers to the table configuration, as described in ‘Adding Registers’. 

Shortcut: 

‘Add registers’ tool   

8.2.10 Add Table 

This command is not available in ‘Auto create tables’ mode. 

All selected ‘unassigned’ registers are placed into a new table by this command. 

Assigned registers are ignored. 

Only those registers associated with the same slave as the first unassigned register will be included in the new 

table. 

This command is greyed out if there are no selected, unassigned registers. 

Shortcuts: 

<Ctrl> + <T> 

Right-click menu ‘Add Table’ item. 
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8.2.11 Autocreate 

 

This allows the user to map programmer block fields to MODBUS registers automatically.  This feature applies 

only to MODBUS slave devices which support PROGCHAN blocks; the selection being disabled for other 

devices and for Profibus communications.   

When clicked on, a dialogue box opens, as shown below. 

 

STARTING ADDRESS FOR NEW REGISTERS: 

Allows the user to choose an address at which to start creating new registers.  This is set by default to 10000, 

in order to try to leave some address space between the user's register mappings and the auto-created 

mappings.  It should be noted that the auto-creation process will overwrite, without warning, any address 

space which is already in use. 

MAP REAL, TIME AND DATE FIELDS AS: 

Real, time and date fields are too big to map to a single 16-bit register.  This pull-down menu allows the user 

to choose a format for such fields.  Choosing 32-bit for example causes the fields to be mapped to two 

consecutive 16-bit registers.  Selecting 16-bit or BCD format truncates the data. 
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8.2.11 AUTOCREATE (Cont.) 

OK 

Clicking on OK causes the software to scan the target database looking for PROGCTRL blocks.  When such a 

block is found, three sets of (contiguous) MODBUS registers are created: PROGCTRL block registers; 

associated PROGCHAN block registers; and SEGMENT block registers (for segments associated with the 

PROGCHAN blocks).  

If this process fails for any reason, a failure message appears in the report pane at the bottom of the window 

(not shown in the figure below).   

 

 

8.3 VIEW MENU 

 

This menu allows the user to enable/disable the display of the Toolbar, the Status bar, and the Report 

Window. 

This menu may also be used to call: 

the TCP properties display (Shortcut <Ctrl> + <D>) 

The Port Properties tab page 

The Register tab page 

The Digital tab page 

The Diagnostic tab page 

The Table tab page. 
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8.4 HELP MENU 

 

This menu allows: 

Access to the Modbus tools Online Help file (this file). 

The user to view the ‘About MdbTools’ display. 

(shortcut: About tool  ) 

8.4.1 About 

 

The ‘About’ tool (above), or the Help menu item ‘About Mdb Tools…’ can be used to call this display. 

Note that the details of the display depend on the version of Modbus Tools currently being used. The figure 

below is given for illustrative purposes only. 

 

 

8.5 CONTEXT MENU 

This menu, which includes the functions of the Edit menu, appears when the right-hand button on the mouse 

is clicked, whilst the cursor is hovering over the main Modbus tools edit area. 

 

8.5.1 Undo (last action) 

Use this command to undo up to the last six editing actions (if possible). The item is ‘greyed out’ if there is no 

previous action to be ‘undone’. 

Other access: 

‘Undo’ tool ,  

<Ctrl> + <Z>, 

Edit menu ‘Undo (last action)’ item. 
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8.5.2 Redo (last action) 

Use this command to reverse the last undo action (if possible). The item is ‘greyed out’ if there is no previous 

undo action to be ‘redone’. 

Other access: 

‘Redo’ tool , 

<Ctrl> + <Y>, 

Edit menu ‘Redo (last action)’ item. 

8.5.3 Cut 

Deletes the current selected registers from the configuration and places them on the clipboard, ready for 

pasting elsewhere. The item is ‘greyed out’ if no registers are selected. 

Other access: 

‘Cut’ tool , 

<Ctrl> + <X>, 

Edit menu ‘Cut’ item. 

8.5.4 Copy 

Copies the current selected registers to the clipboard, ready for pasting elsewhere. The original registers 

remain unchanged. The item is ‘greyed out’ if no registers are selected. 

Other access: 

‘Copy’ tool , 

<Ctrl> + <C>, 

Edit menu ‘Copy’ item. 

8.5.5 Paste 

This inserts a copy of the clipboard contents into the document. The clipboard contents remain unchanged. 

The item is ‘greyed out’ if the clipboard is empty. 

Other access: 

‘Paste’ tool ,  

<Ctrl> + <P>, 

Edit menu ‘Paste’ item. 

8.5.6 Paste Special… 

This inserts a copy of the clipboard contents into a new, user definable location. The clipboard contents 

remain unchanged. The item is ‘greyed out’ if the clipboard is empty or if multiple slaves are included in the 

clipboard content. 

Other access: 

‘Paste To’ tool , 

<Ctrl> + <Q>, 

Edit menu item ‘Paste Special…’ 

8.5.7 Delete 

This item deletes currently selected registers from the configuration. The item is ‘greyed out’ if no registers 

are selected. Unlike the ‘Cut’ command, deleted registers are not placed on the clipboard and cannot thus be 

‘pasted’. 

Other access: 

<Delete> key, 

Edit menu item ‘Delete’. 
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8.5.8 Goto 

From the ‘Tables tab’, this command moves the user to the Register tab or Digital tab which contains the 

highlighted table, and highlights the first register assigned to that table. 

From the Register tab or Digital tab, the command moves the user to the ‘Tables tab’ and selects the table 

that the selected register is assigned to. 

If multiple registers are selected, then the table associated with the first of the selected registers is moved to. 

If the register is not assigned to a table, no navigation takes place. 

The item is ‘greyed out’ if no registers are selected. 

Other access: 

<Ctrl> + <G>, 

Edit menu ‘Goto’ item. 

8.5.9 Add Registers 

This is used to add registers to the table configuration, as described in ‘Adding Registers’. 

Shortcut: 

‘Add registers’ tool   

8.5.10 Add Table 

This command is not available in ‘Auto create tables’ mode. 

All selected ‘unassigned’ registers are placed into a new table by this command. 

Assigned registers are ignored. 

Only those registers associated with the same slave as the first unassigned register will be included in the new 

table. 

This command is greyed out if there are no selected, unassigned registers. 

Other access: 

<Ctrl> + <T> 

Edit menu ‘Add Table’ item. 

8.5.11 Autocreate  

 

This allows the user to map programmer block fields to MODBUS registers automatically.  This feature applies 

only to MODBUS slave devices which support PROGCHAN blocks; the selection being disabled for other 

devices and for Profibus communications.   

When clicked on, a dialogue box opens, as shown below. 
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8.5.11  AUTOCREATE (Cont.) 

 

 

STARTING ADDRESS FOR NEW REGISTERS: 

Allows the user to choose an address at which to start creating new registers.  This is set by default to 10000, 

in order to try to leave some address space between the user's register mappings and the auto-created 

mappings.  It should be noted that the auto-creation process will overwrite, without warning, any address 

space which is already in use. 

MAP REAL, TIME AND DATE FIELDS AS: 

Real, time and date fields are too big to map to a single 16-bit register.  This pull-down menu allows the user 

to choose a format for such fields.  Choosing 32-bit for example causes the fields to be mapped to two 

consecutive 16-bit registers.  Selecting 16-bit or BCD format truncates the data. 

OK 

Clicking on OK causes the software to scan the target database looking for PROGCTRL blocks.  When such a 

block is found, three sets of (contiguous) MODBUS registers are created: PROGCTRL block registers; 

associated PROGCHAN block registers; and SEGMENT block registers (for segments associated with the 

PROGCHAN blocks).  

If this process fails for any reason, a failure message appears in the report pane at the bottom of the window 

(not shown in the figure below).   
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9 COMMAND LINE PARAMETERS 

MDBtools can also be operated using Command Line parameters. 

The following image indicates the parameters that can be configured using the Command line prompt. All 

parameters are single space separated and are case insensitive. 

 

Note: 

This graphic is displayed using the /Help Command line parameter, it shows ALL command line parameters. 

9.1 MDBTOOLS [/ <COMMAND>] <PATH> [/ CSVDELIMITER:] COMMAND LINE 

PARAMETER 

This Command line parameter will create a .csv file from the specified file on the defined path. 

If the path specifies a file, then it must be of type .ujg, .gwf or .csv file. 

Note 

If a file type is not specified, the .ujg file is used. 

If the path is to a folder then the MdbTools retrieves the default .dbf name from the ufolder.ini file, and then 

opens a corresponding .ujg file. 

9.1.1 Example 

MdbTools/Edit C:/../T2550.dbf/CsvDelimiter: 

9.2 / EDIT < PATH > COMMAND LINE PARAMETER 

This Command line parameter runs Modbus Tools and loads the specified .ujg, .gwf or .csv file on the defined 

path. 

Note 

Typing the filename has the same effect. 

9.2.1 Example 

/Edit C:/…../T2550.ujg 

9.3 / CREATEGWF < PATH > COMMAND LINE PARAMETER 

This Command line parameter creates a .gwf file from the specified file on the defined path. 

9.3.1 Example 

/CreateGWF C:/../T2550.ujg 
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9.4 / CREATEUJG < PATH > COMMAND LINE PARAMETER 

This Command line parameter creates a .ujg file from the specified file on the defined path. 

9.4.1 Example 

/CreateUJG C:/…../T2550.gwf 

9.5 / CREATECSV < PATH > COMMAND LINE PARAMETER 

This Command line parameter creates a .csv file from the specified file on the defined path. 

9.5.1 Example 

/CreateCSV C:/../T2550.ujg 

9.6 / CSVDELIMITER: COMMAND LINE PARAMETER 

This Command line parameter loads or saves the specified .csv file on the defined path. 

Note 

The text following the colon ( : ) defines the delimiter. This can be only, COMMA, TAB, or SPACE. 

9.6.1 Example 

/ CsvDelimiter:COMMA 

9.7 / VALIDATE < PATH > COMMAND LINE PARAMETER 

This Command line parameter validates the specified .ujg, .gwf or .csv file on the defined path. 

9.7.1 Example 

/Validate C:/../T2550.gwf 

9.8 /REGSERVER COMMAND LINE PARAMETER 

This Command line parameter enters Modbus Tools registry data to allow the user to open the Modbus files. 

Note: 

This Command line parameter should be used with discretion, as the correct information will have been 

configured when the software was installed. 

9.8.1 Example 

Mdbtools /RegServer 

9.9 /UNREGSERVER COMMAND LINE PARAMETER 

This Command line parameter will remove Modbus Tools registry and will stop the user from opening Modbus 

files. 

9.9.1 Example 

Mdbtools /UnRegServer 
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10 OTHER ITEMS 

10.1 32-BIT DATE AND TIME 

The Date and Time values can be mapped within the constraints of either POSIX or ISO8601 formats. 

10.1.1 POSIX format 

This format maps both values into a single 32-bit number. The values are converted into the total number of 

seconds elapsed since midnight on January 1st 1970. When using this format, the time value is specified in the 

‘Field’ column of the Modbus Tools. 

The rules for deriving these values are as follows: 

If the referenced field is in the Configuration (header) block, the Modbus table maps directly to the 

instrument’s Real-Time Clock completely by-passing the LIN Database. 

Note 

All LIN Configuration (header) blocks have a TIME field, although not all have a DATE field. 

For all other function blocks, the DATE field is found immediately preceding the TIME field. 

Note 

Invalid mapping is caused if the DATE field is not found immediately preceding the TIME field. The Modbus 

register will read as zero and will ignore all further write instructions. 

This format supports Modbus mapping from 

instruments own header block, including a T100 header block which does not have a date field 

any cached header blocks, excluding a cached T100 header block 

Date and Time values in BAT_CTRL block and SPP_CTRL block 

Note 

It also correctly rejects those TIME fields used for other purposes in SPP_CTRL block, SPP_RAMP block, and 

various DCM blocks as ‘not time-of-day’. It does NOT support the TIMEDATE block. 

10.1.2 ISO8601 format 

The ISO8601 format may be used to represent either a Date or Time value. 

A Date value is represented as a decimal number in the format YYYYMMDD. e.g. 14th November 2005 is 

represented as a decimal number, 20051114, and converted to a 32-bit hex value, 0131F4AA. 

A Time value is represented as a decimal number in the format HHMMSS, e.g. 14:02:35 (2 minutes and 35 

seconds past 2pm) is represented as the decimal number, 140235, and converted to a 32-bit hex value, 

000223CB. 
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10.2 CNOMO REGISTERS 

Certain instrument types have the ability to respond to specific CNOMO registers (LIN Modbus Capabilities 

CNOMO Response). 

The CNOMO registers apply to specific data that can be read at pre-defined offsets namely Manufacturer’s 

identity (121), Device type (122), Device Version (123) and a further register Device Heartbeat (124) reserved 

for future use. 

If an instrument is capable of a CNOMO response, then this can be enabled via the check-box on the Auto-

create panel of the Port Properties tab. 

If CNOMO response is enabled then the user will be prevented from using registers in the CNOMO range, 

121-124. If a user adds registers that span these locations then those registers will be reserved as read-only for 

CNOMO use and can not be re-assigned by the user. 

If an attempt is made to add 32-bit registers that overlap with the CNOMO offsets then 16-bit registers will be 

inserted alongside the CNOMO registers to maintain even boundary alignment of 32-bit registers. 
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